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1. Introduction 

Introduction 
 
ArtCAM Insignia allows complex 2D and 3D products to be machined quickly and easily 
from 2D vectors (ArtCAM Wireframe) or bitmaps (Image files). These vectors and 
bitmaps can be generated within ArtCAM or imported from other systems. ArtCAM can 
also import 3D Surface data, which is translated on entry or after as a Relief (3D) model. 
 
ArtCAM Insignia contains tools for creating and editing vectors from which toolpaths can be 
generated. Multiple toolpaths are easily generated for roughing, finishing and engraving. The 
toolpaths can then be simulated to allow complete visualisation of the product before actual 
machining. 
 

Starting ArtCAM Insignia 

• Double click the ArtCAM icon  on the desktop screen with the left 
mouse button. 

 

 
 
 
The ArtCAM start up screen appears as shown above. To start working in ArtCAM the user 
must create a New Model.  
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• Select Create New Model.  
 

 
 

A New Model must have the following defined. 
 

• The X (Width), Y (Height) and Thickness (Z) according to the physical size of the 
model that is required.  

 
• An Origin (datum) position. Click on model sheet to select position. 
 
• Material Z zero.  
Select Top of Block to position the cutting tool on the Material surface. 
Select Machine Bed to to position cutting tool on the Bed of the machine.  
 
• Model Position in Material 
Select Top of Block to align the zero plane of the model with the material surface. 
Select Machine Bed to align the zero plane of the model with the machine bed.  

 
 
• Set the Height and Width as 100 and Thickness as 20 
• Set the units as mm and select the origin in the centre. 
• Set Material Z Zero at Top of Block and Model Position on the Machine 

bed. 
 

 
 
• Select OK. 
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ArtCAM opens up displaying the 2D view, with any Relief and Toolpaths displayed in the 
3D View. You can toggle the views by selecting  (or F2 or F3 
shortcut key).   
 
 
The 2D view is traditionally used for designing vectors (2D artwork) and bitmaps (images). 
Imported Reliefs (3D models), Toolpaths and Simulations can be viewed in 3D. 
  
 
 
 
 
 
The following pages will summarise the key areas and available functionality within the 
default 2D and 3D environments.  
 
ArtCAM commands are accessed from the drop down Menu Bar options or directly from 
their respective Toolbars. 
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2D View Summary. 
 
The following summarises the key 2D view area and functions (default settings). 
 
 
 

 
 
 
 
 

 Zoom In > Zoom in the 2D view. 
 

 Zoom Out > Zoom out the 2D view. 
 

 Zoom Previous > Zoom to the previous view. 
 

 Zoom 1:1 > Zoom to 1 image pixel = 1 screen pixel. 
 

 Window Fit > Fit the artwork in the view. 
 

 Zoom objects > Zoom to fit the selected object(s). 
 

 Preview Relief layer > Show a colour preview of 3D Relief in the 2D view. 
 

 Bitmap Transparency > Adjust transparency of Bitmap in the 2D view. 

Model / Material 
(White region only) 

Main Pull Down Menu 

Default Toolbars 

Project Panel 

Coordinates Colour Palette 

2D View Toolbar 

Default Flyout Panels 

Project Tree 
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3D View Summary. 
 
The following summarises the key 3D view area and functions (default settings). 
 
 
 

 
 
 
 

 Isometric View. 
 

 View along the X axis. 
 

 View along the Y axis. 
 

 View along the Z axis. 
 

 Zoom In. 
 

 Zoom Out. 
 

 Zoom to previous view. 

Z Zero plane 
(Gold region only) 

Zoom Tools 

Origin 

3D View Toolbar 

View Tools 

Defined material 
block (blue) 
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 Scale view to fit. 
 

 Objects to draw (view) dialogue box. 
 

 Control various 3D graphics options. 
 

 Toggle Z zero plane. 
 

 Toggle drawing of the origin. 
 

 Toggle visibility of root assembly (in project)  
 

 Toggles between displaying flat and rotary reliefs. 
 

 Toggles visibility of the defined material block. 
 

 Toggles visibility of the simulation block (from machining). 
 

 Toggles colour shading (bitmap) 
 

 Toggle display of the front relief. 
 

 Toggle display of the back relief. 
 

 Toggle relief gradient analysis tool. 
 

Main Menu Bar 
 
At the top of the Main window, there is a Pull Down Menu Bar. 
 

 
 
 
Clicking on a menu item opens a pull-down menu that contains submenus and commands. If a 
menu item does not apply to the currently active view it will be greyed out.  
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Sub menus are indicated and selected via the arrow  at the right hand side (where 
applicable).  
 
For example, the File menu expands to show the following. 
 

 
 
A yellow bar highlights the function over which the mouse cursor passes. Left mouse button 
then activates the function. 
 
On certain commands, the keyboard shortcut is listed next to the description. For example, the 
shortcut to create a new model would be to press the CTRL key and then the letter N. 

Toolbars 
 
The default toolbars are summarised below.  
The left hand side of the ArtCAM interface is occupied by a Toolbar. This is the Design 
Tools Toolbar and contains four key design areas. 
 
 

 
 
Selection Tools 
This section contains tools that change the vector mode, such as the default select 
function, the Node Editing and the Transform function. 
 
Bitmap Tools 
This section contains the most common tools for painting and working with colours. 
Items such as paint brush, flood fill and pick colours are located here. 
 
Vector Tools 
This section contains all the main vector drawing tools. Available are the creation of 
Polylines, Squares, circles, ellipses, stars, polygons, arcs and text. 
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File Toolbar 
 

 
 
Contains the standard Windows functionality including the Help reference and Options 
settings. 
 
 

 New Model/New Project > Creates a new blank ArtCAM Model or Project (flyout). 
 

 Open > Open an existing ArtCAM file or image (.art, .bmp, .tif, .gif, .jpg, .rlf (relief)). 
 

 Save > Save the current ArtCAM model or Project. 
 

 Cut > Move the currently selected object to the clipboard. 
 

 Copy > Copy the currently selected object to the clipboard. 
 

 Paste > Paste the currently selected object into the model. 
 

 Undo > Undo the last command 
 

 Redo > Redo the last Undo command 
 

 ArtCAM Notes > Add written notes to the current ArtCAM file. 
 

 Help > Launch ArtCAM’s online help.  
 

 Options > Change global settings for ArtCAM. 
 

Model Toolbar 

 
 
Includes tools to modify the Model size, resolution, Origin, Position and Lighting 
(shading). 
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Vector Creation  

 
 
Advanced creation tools for vectors including Offset, Bitmap to vector and Nesting. 
 

Relief Creation 
 

 
 
Tool to Paste a Relief into the current layer. 
 

Relief Editing 
 

 
 
Tools to Reset and Scale the imported Relief. 

Vector Editing 
 

 
 
Tools to edit current vectors such as Vector doctor, Wrap vectors, Clipping, and 
Mirroring. 
 

Flyout menus 
 

Several icons have a small arrow    located at the bottom right hand corner.  
This indicates that this icon has further hidden functions which can be accessed from a flyout. 
 
Select and hold the left mouse button over an icon (with the arrow) will reveal the functions 
in the flyout menu. Releasing the mouse over the desired function will activate it. 
 
 
 
For example selecting the Circle icon from the Design Tools 
Toolbar reveals the ellipse. 
 
 
Selecting Draw reveals the Paint and Paint selective functions. 
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Project Panel 
 
The right hand side of the ArtCAM interface is occupied by the Project Panel and several 
Flyout panels. 

 
 

 
The Project Panel serves as a central area to manage the main design 
and machining aspects of the ArtCAM model.  
When an item is highlighted, the lower half of the panel displays 
further information.  
 
 
 
 
 

 
A summary is provided below. 
 

   Summarises the Model information. 
 

   Displays the Vector layers Toolbar. 
 

   Displays the Bitmap layers Toolbar. 
 

   Access to all 2D and 3D Toolpath functions. 
 
 
Right mouse selecting on an item in the Project Panel reveals the equivalent functionality 
(summarised above). 
 
 
For example, Right mouse selecting the Vectors option reveals all the 
Vector Layers functionality. 
 
 
 
 
The functionality above will be discussed in greater detail throughout the training course.  
 
Note: Although the Project panel provides a central area, all individual functionality shown 
above can also be accessed from either the top Pull down menu, or their specific toolbars.  
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Flyout Panels 
 
The four default hidden panels on the right hand side can be activated by simply holding the 
mouse cursor over the desired flyout tab. 
 

 
The Tool Settings Panel displays all the settings and information about 
the current or active function. 

For example, If the create circle function  is selected, The Tool 
settings Tab will reveal the Circle Creation form where required sizes and 
coordinates can be entered. Keyboard shortcut F6 also reveals this tab.  
 
 
 
The Toolbox Panel reveals external ArtCAM Plug ins (applications) that 
have been created and are compatible with ArtCAM. For Example, the 
Face Wizard can be found here. 
 
 
 
The Tutorials panel will provide a resource for Training materials and tutorials.  
 
 
 
 
New to 2010, The Live Panel will provide access to an online database of 
Training videos. This area is subject to live updates and additional videos 
released by Delcam. Note: Internet access is required to obtain this 
resource. 

 
 
 

Fly out Panels can be fixed (stay out) by selecting the Pin icon  
at the top right hand corner of the panel. 
 

Reselecting the Pin will hide the panel.  
 
Selecting the cross  will close and remove the panel tab from the screen. 
 
 
 
The following section will outline the ability of ArtCAM 2010 to customise the interface 
including adding and removing toolbars, functions and Fly out panels. 
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Interface customisation 
 
Right mouse selecting in the toolbars or grey border region will present the following 
menu. 
 
 

 
  

The top half of this menu lists all the standard 
 toolbars available in ArtCAM. Items indicated by the 

Tick,  are currently visible. Selecting or unselecting 
 the option will toggle its visibility from the interface. 
  
 
  
 
 
 
 
 

The lower half of this menu lists all standard Fly out 
 Panels available in ArtCAM.  

As above, selecting/unselecting the  will toggle its  
visibility. 

 
 If a Panel was closed  previously, it can be 
 reactivated here. 
 
 
 
 

Selecting Customise will present a new menu which 
allows extensive customisation of the layout. This is  
outlined below. 

 
 
 

 All Commands are listed here. These can be 
dragged and dropped into existing visible toolbars. 
  

 Toggles Toolbar visibility and ability to create a 
new customised Toolbar. 

 
 Keyboard shortcuts can be assigned here. 

 
 Options to customise menu including animation. 
 
 General Toolbar options including Tool tips and 

icon size. 
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Docking Toolbars 
 
Toolbars can be dragged into the interface and allowed to ‘float’ in a desired location. 
 
At the end or top of each toolbar there is a dotted line.  
 
 
 

When the mouse cursor is placed over this line, it changes to a cross  at which point the 
toolbar can be selected and dragged. 
 
 
Double Mouse clicking in the top margin area of the Toolbar 
returns it to the original fixed location. 
 
 
 
 
 
 

Docking Fly out Panels 
 

When a Fly out Panel is fixed,  it also can be dragged (to float) or docked in a fixed 
position at each end of the screen. 
 
 
Select and Hold the mouse cursor in the top margin 
to drag the Panel into the screen.  
 
 
Whilst dragging, the interface displays a cursor pad in the centre and edges of the page. 
Depending on which arrow the panel is moved over, the screen will display a blue region 
where the panel will dock. Release the mouse button to dock the panel in this location.   
 
Panels can also be docked onto the top or bottom half of other fixed Panels. This is achieved 
by dragging a panel (as described above) onto another Panel to activate the ‘cursor pad’. 
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Themes and Layout 
 

From the top Window  drop down menu, a number of interface options are 
available. 
 
From Window > Theme….. 
 
Select Classic to change the colour scheme from the current 2010 theme a traditional 
ArtCAM background. 
 
 

 
 
From Window > Reset Layout…… 
 

 
 
 
Select ArtCAM 2010 to quickly reset the interface to default settings. 
 
Select ArtCAM 2010 Advanced to change the interface to an advanced setting where all 
toolbars are switched off. 
 
Select Classic to change the interface back to ArtCAM 2009. 
 
 

ArtCAM Help 
 
By selecting Help > Index from the top Menu bar (or by pressing the F1 shortcut key) a Help 
Page will open over the graphics area. 
 
 

 
 
Further sources of information and help can be 
obtained from the ArtCAM website and dedicated 
Forum.  
 
 
 

 
 
Individual function forms can be expanded to provide a detailed explanation of each available 
option/entry. 
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This is achieved by selecting the Help icon  in the top right hand corner of the active 

form. The example below applies to the Rectangle creation function.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ArtCAM File structure 

ArtCAM Models (*.art)  
 
An ArtCAM Model will contain all entities created within the session such as Bitmaps 
(image files), Vectors (2D geometry) Reliefs (3D models) and Machining data (Toolpaths). 
This ArtCAM file is identifiable by having an .art extension and can be saved or exported as 
a whole. 
 
It is also possible to Import and save/export independent entity types from within the 
ArtCAM Model. These include the Vectors (mainly .eps .dxf .dgk .pic formats), Bitmaps 
(.bmp, .gif, .jpeg), and Machining Output (.tap). 
 
For more advanced applications where it is required to create an assembled group of separate 
Relief models (.rlf), an ArtCAM Project is first opened in which several ArtCAM Models 
can be created and combined as required for an assembled item. When saved, the Artcam 
Project is identifiable by a .3dp extension. To enable the Reliefs to co-exist together, the 
individual components are converted within the Assembly as Triangle Mesh models. 
ArtCAM can also import surface models (e.g. iges) directly into an assembly. 

Design 
 
Vectors (2D artwork) and bitmaps (images) can be generated within ArtCAM or imported 
from other systems. ArtCAM can generate reliefs from an imported model.  
When dealing with bitmaps and Reliefs it is important to understanding Resolution, which 
will influence the overall surface detail of the relief and ultimately the final piece. 
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Manufacture 
 
The final stage for most ArtCAM models is to manufacture the design as a real object.  
ArtCAM can calculate the toolpaths required to machine the vectors directly or relief. The 
calculated toolpaths can be then sent directly to the machine (via post-processing) ready for 
cutting. 
 
 
Mouse buttons application 
 
Each of the three mouse buttons performs a different operation in ArtCAM Pro 3D View 
(F3). By using the ALT, Ctrl or Shift key on your keyboard, these operations can be 
extended as the following details explain. 
 
 
Left mouse button: Picking and selecting 

 
 
This button is used for selecting items off the main pull down 
menus, inputting data and selecting parts of the model. 
 
 
 
 

 
Middle mouse button or wheel: Dynamics 

 
Zooming: 
 
Scroll the middle mouse to Zoom IN/OUT of the model. This applies 
to the 2D and 3D view. Alternatively, Select the SPACE BAR and 
Right mouse button together and move the mouse to Zoom IN/OUT. 
This option applies to the 3D view only) 
 
Panning: 

 
Hold down the Left and Right mouse buttons and                                      
move the mouse, to move the view across the component. 

 
                                     Rotating/Twiddle:  
 
                                     Hold down the middle button/wheel and move the 

 mouse. Alternatively Select the SPACE BAR and Left mouse      
button together and move the mouse. This option applies to the 3D 
view only) 
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2. Generating Vectors 

Overview 
 
Vectors are mathematically defined shapes consisting of a series of points (nodes), which are 
connected by lines, arcs or curves (spans) to form the overall shape.  
 
They can be: 
 

• Generated directly within ArtCAM by using the Vector Tools in the Assistant page; 
• Rectangles, Squares, Circles, Polylines, Ellipses, Polygons, Stars or Text that can 

be edited if necessary to generate the final vectors to create a Relief from; 
• Imported from another drawing package, using the File – Import menu option, or 

copied and pasted from another package using the standard Windows commands. 

Mobile Phone Cover Exercise 
 
In the following exercise you will generate a Mobile Phone Cover using the Vector Tools.  
Below is a drawing of the item including basic dimensions, so that you can get an idea of how 
the final product should look before working through the ‘step by step’ instructions. 
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• Select New Model.  
• Enter a Height of 150mm, a Width of 80mm and a Thickness of 15mm. 
• Set the Origin to the centre and both Z Zero and Model Position at the 
Top Of Block.  
 

 
 

 
• A new ArtCAM Model (sheet) is generated based on the parameters 
defined above. 
 
 
The vector creation tools (any many others) can be accessed in a number of ways. 
 
 

1. The default Design Tools toolbar on the left hand side. 
 
 
 
 
 
 
 

2. Activate the Assistant Tab by right mouse selecting in the 
grey border. 

 
 
 

3. Right mouse select in the white model sheet 
and select the Drawing options. 
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• Using a method outlined above, Select Create Rectangle.  
 
• The Rectangle creation form appears in the Tool settings form. 
 

 
• Enter a Width of 50mm, a Height of 120mm, Corner Radii of 3mm and a 
Centre Point of X 0 and Y 0. 
• Select Preview to view the proposed shape (represented as dashed lines) 
 

 
 
• To create the shape, single left mouse click in the view area. 
 
The rectangle is created on the model page whilst keeping the rectangular creation form open. 
This can be utilised to create a new rectangular shape. 
 
Note: A single right-mouse click would create the shape, but close the vector creation form. 
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The outer shape of the phone cover is created. 
 
 
 
 
 
• In the Rectangle Creation form, change the Width to 40mm, Height to 
30mm, Corner Radii to 1mm and the Centre Point to X0 and Y20. 
• To create the shape, single right mouse click in the view area (and close 
the form) 
 
 
 
 

This second Rectangle will represent the display window.  
 
 
 
 
 
 
 
 

• Select Create Ellipse.  
• Enter a Start Point of X –14 Y –50 with a Height of 7mm, Width of 10mm 
and an Angle of 140 degrees.  
 
 
• Right mouse click to create the shape. 
 

 
 
 
 
A block pattern of this single Ellipse can be created quickly to complete 
the keypad. 
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• With the Ellipse selected, click on the Block Copy / Rotate  icon from 
the Vector Tools area on the Assistant’s page or top of the screen. 

 
 

 
 
 
 
The Block and Rotate Copy allows you to create a 
block copy in X and Y or a rotated copy around a 
point. 
 
The distances can be set as an offset value or by a 
gap value between each item. 
 
 
 
 
 
 
 
 
 

 
 
• Select Block Copy and Distances are offsets options. 
• Select an X Offset of 14mm, with Number of Columns as 3. 
• Select a Y Offset of 10mm, with Number of Rows as 4. 
• Select Apply. 
 

 
 
 
 
 
 
 
The keypad is created.  
 
A centre ‘menu’ button will be created from two combined 
circles. 
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• Select Create Circle.  
 
 

 
 
• Tick the option Create with Arcs. 
 
• Create a circle with centre at X0 Y–4, radius as 4mm.  
• Create a second circle or radius 4mm but with centre at X0 Y–8. 
 
 

 
 
 
 
The Circles will now be ‘merged’ into one. 
 
 
 
 

 
 
 
 

• Select both circles and select the Weld button  from the Position, 
Combine, and Trim Vectors area on the Assistant’s page. 
 
 
By welding the two Circle vectors, a new single vector is created. 
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Note: The Weld command only works on two selected 
closed vectors. 
 
 
 

 
• Zoom in to see the vector more clearly. 
 

Zoom either using the  tool or middle mouse cursor.  

• With the new vector selected, select Node Editing.  
• Hover the mouse over a left black node, press the right mouse button 
and from the side menu select Smooth Point (or press S on the keyboard). 

 
 
• Repeat for the other side to provide a shape with smooth inner corners. 
• Press N to return to Select mode and click away from the vector. 
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• Select Create Polygon.  
 
 

 
 

 
• Enter No. of Sides to be 3, Angle 0, Polygon Centre at X –14, Y –2 with 
a Radius of 4mm. 
 
• Create the triangle shape (left/right mouse click) 
 
 
 

 
 
 
 
 

• With the Triangle vector selected, select Offset Vector(s).  
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• Select an Offset Distance of 1mm, Offset Direction as Outwards and 
Offset Corners as Radiused. 
 
• Select Offset to create the new shape. 
 
 
 

 
 
The new vector is Radiused at the corners. 
 
 
 

 
 
• Select the original inner vector and press Delete on the keyboard. 

• Select the new vector and select Mirror Vectors.  
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The Mirror Vectors page allows you to mirror 
the selected vectors about themselves or about 
a selected line. 
 
 
 
 
Note: You must select the mirror line first 
before applying the Mirror Vectors - About 
Line option.  
 
 
 
 
 
 
 
 

 
 
• Select  Copy the Original Vectors (Ctrl),  

• Select Bottom  to create the mirrored triangle. 
 
 

 
 
 
The new vector will be moved downwards. It can be nudged using 
the down arrow or moved more accurately by a value using the 
Transform Vectors command. 
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• Select Transform Vectors  (or hit T twice on the keyboard). 
 
 

 
 
• Enter Move Y as –1, select Apply.  

• Select both Triangular vectors and then select the Group button.   
 
     The two items can now be treated as one. 
 
 
A polyline will be created to use as a mirror line for this grouped feature.. 
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• Select Create Polyline.  
 
       

 
 
 
Polylines can be generated by entering absolute co-ordinates in the X and Y area, by angles 
and line length, as relative co-ordinates using the dx and dy (distance from last point) or by 
clicking with the cursor. 
 
Note: Polylines can also be created dynamically in the graphics area either by holding down 
the left mouse key while freehand sketching a curve, or by using the left mouse key to click 
individual points along the required route. 
 
• Select Add (enters a point at 0, 0). 
 
• Enter 30 in dy (30mm in Y direction), select Add and then Close. 
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• Select the Polyline first and then shift select the triangle group. 

• Select the Mirror button.  
• Select  Copy the Original Vector option. 
• Select About Line to create the mirrored feature. 
• Delete the Polyline. 
 

 
 

• Select Create Vector Text.  
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• Select Font as Arial, Script as Western and Size as 3mm. 
 
• Click at the bottom of the 2D View and type ARTCAM VECTOR TEXT. 
• Select Done. 
 
 
 

 
 
This Text can be wrapped around the outer 
vector, with the text inside, using the Wrap 
text round a curve option. 
 
 
 

 

• Select Wrap text round a curve.  
 

 
 
The Text on a Curve page appears, which 
allows you to align an existing Text Vector to a 
Curve Vector.  
 
 
Text Position includes options that control the 
relative, position of the text across the curve. 
 
Text on other side puts it on the other side of the 
curve. 
 
Text Alignment includes options that control the 
flow of the text along the curve. 
 
Text Spacing allows you to vary the spacing 
between the individual characters. 
 
 
 
Editing Style allows you to set individual 
Words or       Letters to be repositioned around 
the curve independently. 
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• Select the Text and shift select the outer vector and press Select in the 
Text on a Curve page. 
 
• Select the Text Position option as Specify and enter 1mm.  
 
 
• Tick the option Text on other side. (if text is on the outside) 
• Select the Editing style option as Single Words. 
• Dynamically Move the text using the cursor to align on the three sides 
as shown below. 
 
• Select OK 
 
 
 
 
 

The Text is now wrapped. 
 
 
 
 
 

• Select Create Polyline  and in the form select the option Draw 
smooth polylines.  
 
• Left mouse click 5 suitably positioned points to create a Smooth Polyline 
similar to the one shown below. 
 
 
 
 
 

You will use this Polyline to paste vectors along. 
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• From the Vector Tools area, select Create Stars.      
 
 

   
 
 
• Enter No. of Points as 5, Star Centre as X –28, Y 62, Radius of first 
Points as 4.5mm and Radius of second Points as 2mm. 
 
• Preview and create the star. 
 
• Select the Star vector and shift select the sketched Polyline. 
 

• From the Vector Tools area, select Paste along Curve.  
 
 

 
 
 
The vector is pasted incrementally along the curve either by dividing the curve equally 
(Specify Number), or by a fixed distance, leaving any surplus at the end of the curve 
(Specify Distance). 
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• Select Specify Number and enter Number of Copies as 5. 
• Select Paste. 
 
• Delete the original Star vector and the sketched Polyline. 
 

 
 
 
 
• Select File - Save As, browse: 
 
D:\users\training\COURSEWORK \ArtCAMPro-Jobs and enter as File name - 
training-phone-cover.  
 
• Select File - Close Model. 

 

 

 
 
 
 
 
 
 
 
 
 

                                                   Issue ArtCAM Insignia 2010                                                              2.17 



2. Generating Vectors                                                                                  ArtCAM  
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3. Vector Editing and Layers 

Vector Editing 
The following chapter will introduce several Vector Editing options. 

Shield Design Exercise 
 
• Create a New Model with a Height of 20mm, Width of 20mm and a 

Thickness of 15mm. 
• Set the Origin to the centre and both Z Zero and Model Position at the 

Top Of Block. 
 
Note: 

You can also move the origin position by using the option Set Model Position.  
This allows you to position the zero datum to the Centre, one of the 4 corners or a typed 
coordinate position.  
 

Vector input by snapping to a Grid 
 
• From the top file menu, Select Bitmaps – Views - Snap Grid - Snap Grid 

Settings… 
 

 
 
Grids provide snap points to assist in dynamically 
defining vector points. They are available from the 
Bitmaps - Views pulldown menu. 
 
 
The selected grid spacing value is mainly dependent on the 
size and complexity of the component to be produced. 
 
 

• Set the Grid Spacing to 1 and select OK. 
 
• From the same top file menu, switch ON the options Snap to Grid and 

Draw Snap Grid. 
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A grid is displayed in the view, with an even point 
spacing of 1mm. 
 
 
 
 
 
 
 

 

• Select Create Polyline.  
 
• Snap to the same Grid points as shown in the image below. 
 
 

 
 
 
Note: The best position to Snap in a vector point is just to the 
lower, left of a Grid point. 
 
 
 
 
 
 

 
• Select File - Save As: 
     D:\users\training\COURSEWORK\ArtCAMPro-Jobs\train-shield. 
• Switch OFF both Snap to Grid and Draw Snap Grid. 
 

• Select Fillet vector with an arc.    
 
 
 
 
The Fillet is generated at a node point or from 
two Polylines that would intersect. 
 
 

3.2 Issue ArtCAM Insignia 2010 



ArtCAM                                 3. Vector Editing and Layers 

 
 
• Enter a Fillet Radius of 5mm and select line either side of the bottom 

point to generate the fillet. 
• Change the Fillet Radius to 1mm and create a Fillet at the top two 

corners. 
• Change the Fillet Radius to 2.5mm and create a Fillet at the bottom two 

corners. 
 

 
 
 
 
 
The main shield vector is as shown. 
 
 
 
 
 
 

 
• Close the form. 
 

• With the vector selected, select Offset Vector.   
• Set an Offset Distance of 0.5mm, select Inwards and Radiused. 
• Select Offset, followed by Close. 
 
 

Vector input by snapping to Guidelines 
 

 
You’ve created a constant Offset. For the middle part, instead of 
using Grid lines, Guidelines, you will input actual values. 
 
Guidelines are pulled from within the rulers located around the 
border of the model. For accurate positioning they can be 
snapped direct to Grid points or if the Grid is switched off once 
created they can be precisely positioned via a Position Guide 
form. 
 

• Hold the left mouse button down within the top ruler (as shown) and drag 
down a horizontal Guideline. 
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• Release the left mouse button, when it is near to the centre of 

the model.  
 
• Right mouse click on the Guideline to activate the position guide. 
 

 
This form allows the guideline to be accurately positioned, 
deleted or further guides to be inserted. 
 
 
• Enter a New Position of 0 and select Apply. 
 
• Repeat the process to generate a vertical 

Guideline at 0 (by dragging it from within the 
left ruler.)  

 
 

 
The two guidelines intersect at the origin. These guidelines 
can be snapped to, when creating or moving vectors or nodes. 
 
You can show or hide these Guidelines by clicking 
on the Guidelines icon in the top left corner of the 
rulers. 
 
 
 
 

• Select Create Polyline.   
• Snap on the Guidelines to create horizontal and vertical centrelines. 
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• Pick the top left corner icon in the 2D View to switch off Show 

Guidelines.  
 
 
The two new Polylines will be used to create Offset Copies by setting the on Both Sides 
(Ridge) option. 
 

• Offset  the horizontal Line vector both sides by 0.5mm selecting the 
Both Sides (Ridge) option. 

• Offset  the vertical Line vector both sides by 0.4mm. 
• Delete the original Polylines (if the Delete original vectors option was 

not set during the offset operations). 

• Select Trim vector to intersections  and trim the Polylines to fit 
within the shield. 

 
 
 
 
 
 
The completed vectors for the shield design are 
as shown.  
 
 
 
 
 
 
 
 
 

 
 
• Select File - Close Model (do not save) 
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Vector Layers 
 
 
Vector Layers provide a more ordered method of managing the selection and display of 
selected groups of vectors. In default mode ArtCAM Pro assigns all vectors produced to  
a layer named Default Layer (which cannot be renamed or deleted). Any additional Vector 
Layers can be Renamed, Deleted and Merged together. As new Layers are created specific 
group of vectors are assigned to them as required. The layers Tab also allows the user to 
Open (Import) and Save (Export) vector data. 
 
 
The Vector Layer Toolbar can be activated by right mouse 
selecting in the Grey border (Right hand side) and selecting 
Vector layers. 
 
 

 
 
 
Vector Layers are controlled by this toolbar. The default layer is highlighted and any 
generated or imported vectors will be displayed, providing the layer in switched on (light 
bulb). 

Phone Cover Exercise 
 
• Open the model training-phone-cover. art from 

D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 
 
 
 
 
 
 
 
This exercise will show how to import vectors and also move or 
transfer existing vector data to other layers.  
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• Select the stars vector group. 

 
 
 
Layers need to be generated before vectors can be 
placed into them. It is good practise to give the 
layer a sensible name. 
 
 

 
 
 

•  Select New  on the Vector Layers toolbar.  
 

 
 
New Vector Layer 1 has been created. By double-clicking on the name itself, the name can 
be changed. 
 
• Double click on New Vector Layer 1, overwrite as stars and select Enter 

(or mouse click away from the name) to confirm.  
 

 
 

The new level is now named and switched on (denoted by the light bulb icon).  
 
• Right mouse click on the selected star vector group and select Move 

Vectors To… > stars.  
• Switch off the Layer stars by clicking the light bulb. 
 

 
 

 
 
 
The star vectors are now hidden. The other vectors on the default 
level are still displayed. 
 
Note: When a Layer is current (highlighted in colour) any vectors 
that are pasted are automatically placed on that layer. 
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• Create a new Layer and change the name to buttons. 
• Create a new Layer and change the name to holes. 
 

 
 
• Select the 12 Ellipse vectors. 
 

 
 
The selected vectors will be transferred to another Layer. 
 

Note: Layers can have the snapping facility  switched on or 
off. For example if you had vectors close together and wanted to 
be sure you snapped to the correct vector on a layers, then you 
would switch snap off for all the other layers. 
 
 

 
• Right mouse click on the selected button vector group and select Move 

Vectors to…..> buttons.  
• Select the other shaped vectors as shown. 

 
 
 
 
These selected vectors will be placed on another Layer. 
 

Note: Layers can be locked,  so any vectors on that layer 

cannot be moved or edited until the layer is unlocked.  
 

 
 
 
 
• Right mouse click on the selected vector group and 

pick Move Vectors to….. > holes.  
 
 

• Switch off the Default Layer,  leaving on the layers 

buttons and holes.  
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The vectors displayed are going to be combined into the one current layer Merged Layer 1. 
 

• Select Merge Visible.  
 

 
A new Layer called Merged Layer 1 has been 
created with the visible data combined. The vectors 
on the layers can be coloured for identification. 
 
 

 
 

• Select the black circle  to the left of the 
Layer name Merged Layer 1. 

 
 
The colour form appears. This allows you to select the 
colour for the vectors on that layer.  
 
 
 
• Select any suitable colour and then OK. 
 
• Switch on all the Layers using the Toggle All Visibility. 

 
• Select Open  from the Vector layers toolbar. 
 
• From ArtCAM Data, select the file tel-insert.eps and 

select Open. 
 
 
The vectors are imported as a group on a new layer (same as 
filename), so to use them individually, they need to be ungrouped. 
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Vectors can also be imported from the main menu by first highlighting the required vectors 
and then selecting Vectors > Import…. from the top menu. 
 

 
 
Similarly, vectors can also be exported by selecting the desired vectors and then selecting 
Vectors > Export…. from the top menu. 
 

 
 

Selecting  from the Vector layers toolbar, will export all vectors on that layer. 
 
 
 
• Select File > Save. 
• Select File > Close Model. 
 

Node Editing 
 
The structure and appearance of a vector can be changed using the Node editing options. 
Vectors are made up of nodes and spans which are displayed only when ArtCAM switches to 

Node Editing Mode.  
 
 

Upon selecting a Vector, Node Editing can be entered by selecting  from the Design 
Tools Toolbar on the left hand side, the Right mouse select menu or simply selecting N on 
the keyboard. 
 
 

 
 
 

node 

Vector mode Node mode 

span 

control point 
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The following example illustrates the different options available for editing nodes, spans and 
control points within selected vectors. 
 

Enamel-Pin Exercise 
 
• Create a New Model with a Height of 20mm and Width of 60mm. (Origin 

in centre) 
• Create a Guideline at X 0 and Y 0. 
 

• Select Create Polyline.  

• Untick the Draw smooth polylines option.  
• Enter X as –25mm, Y as 1mm and select Add. 
• Enter dx as 35 and select Add. 
 

• Select Create Polyline.  
• Enter X as –25mm, Y as –1mm and select Add. 
• Enter dx as 35 and select Add.  
 
Note: Selecting the Spacebar will stop the Polyline creation at the last point. A new start 
point can then be created. 
 

You can join these two vectors 
together with either an arc, straight 
line or by moving the end points. 
 

 
• Select both vectors. 

• Select Join Vectors With A Curve.   
 
You’ve joined the two vectors 
together to make a new vector. 
You will close the open vector. 
 

• Select the new vector. 

• Select Close vector with a Line.  
 

The vector has been closed. You 
will now modify an Ellipse to 
produce a leaf shape. 
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• Select Create Ellipse.  
• Enter a Start Point of X -4mm Y 4mm, an Ellipse Height of 3mm and 

Width of 12mm with an Angle of 340 degrees. 
• Create the Ellipse shape (single mouse click on model sheet) 

• Select the Ellipse and then Select Node Editing.    
 
 
By pressing N on the keyboard on a selected vector, you will 
switch between Node Editing mode and Select Vectors mode. 
 
You will open up the Ellipse halfway by removing spans using 
the right mouse button menu. 
 

 
 
 
 
 
The part of the vector between two node points is called a 
span. If a span was removed, the vector will become 
open. 
 
In Node Editing mode, if you move your mouse over a 
node point and click the right mouse button a local set 
of menus appears. 
 
 
 
 

 
• Right mouse click over the right bottom span of the Ellipse and select 

Remove Span from the menu. (The span mode is indicated by ~) 
 
 
The Ellipse vector is opened at the required area. You’ll 
need to delete the other lower span. 
 
 
 

• Right mouse click over the left bottom span of the Ellipse and select 
Remove Span from menu. 

 
Only half of the original Ellipse remains. You will close 
this half Ellipse with a line in the Select Vectors mode. 
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• Select Select Vectors.  

• With the vector selected, select Close Vector with a Line.  
 

 
 
The vector is now closed. You will now create a 
Polyline to mirror the vector across. 
 
 
 
 

• Select Create Polyline.  
• Enter X as –10.3mm, Y as 1.5mm and select Add. 
• Enter X as 3.6mm, Y as 6.6mm and select Add. 

• Shift-Select the Polyline, the leaf shape and then Mirror Vectors.  

• Tick the Copy the Original Vectors option and select About Line.  
• Close the form.  

• Select the Polyline and select Cut.   
 

 
 
The leaf shape has been generated. This will now be 
mirrored to the other side. 
 
 

 

• Select Create Polyline.  
• Snapping to the horizontal Guideline, create a single line across the 

model. 
• Select the new horizontal vector and the leaf shapes. 

• Select Mirror Vectors.  

• Select Copy the Original Vectors and the About Line option.  
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• Select Create Circles.   
• Set the Circle Centre as X 10mm Y 0, select Radius and enter 1.5mm.  
• Deselect Create with arcs, before creating the circle. 
• Create a new Circle with Centre at X 16mm Y 0, and Radius of 6mm.  
• Select Create followed by Close. 
 

 
 
 
The smaller circle will be subtracted from the larger circle. 
 
 
 
 
 
 

• Select the larger circle and then shift select the smaller circle. 

• Select Subtract vectors.   

• Select Node mode.  
 

 
 
• Move the mouse over the top marked area 

and from the right mouse menu select insert 
a point. 

 
• Move the mouse over the bottom marked 

area and from the right mouse menu select 
insert a point. 
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The addition of these extra node points will allow you to 
move the node point in between the new points and it will 
only stretch the vector within that region.  
 
 
 
 
 

 
 
• Select the middle node. 
• Drag the point along the horizontal vector (towards the origin) and 

release the mouse at a suitable position as shown in the image below. 
• Delete the horizontal vector. 
 

 
 
 
 
 
The two control points can be dragged to produce a more 
realistic     curve. 
 
 
 
 
 

• Select each control point and move around as shown in the image below. 
 

 
 
 
 
The shape is complete. You’ll have to create another Polyline 
to build the inner part, using the smooth option. 
 
 
 
 
 
 
 

• Select Create Polyline.  
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• Tick the Draw smooth Polylines option. 
• Select several points on the model to make the shape roughly as shown. 

 
 
 
The last point is not smoothed when it is joined. You can 
smooth it in the Node Editing mode. 
 
When you are in the Node Editing mode the smooth point 
shows as blue and a non-smooth point shows as black. 
 
You can now Offset all of the vectors. 
  
 

 
• Click on the start point to complete a single closed vector.  
 

• Select Vectors.  
• Select all the vectors.  

• Select Offset Vectors.  
• Select an Offset Distance as 1mm, Offset Direction as Outwards/Right 

and Offset Corners as Radiused. 
• Select Offset, followed by Close. 

 
 
 
The design is complete.   
 
 
 
 

Selected Node Editing 
 
When a node is selected it turns red and can be moved dynamically. Shift and select allows 
the user to select several nodes in a curve, ctrl and select allows the user to pick individual 
nodes, to be moved simultaneously. 
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Selecting X on the keyboard edits the selected points with the X coordinate of the last node.  
 
Selecting Y on the keyboard edits the selected points with the Y coordinate of the last node. 
 

Vector Clipping and Slicing 
 

Vector Clipping  is used to trim a group of vectors within a defined vector. 

Vector Slicing  is used to split a vector across a selected cutting vector. 
 

Vector Clipping Exercise 
 
• Create the following vectors in a New Model of size 100 x 100 and Origin 

at the centre. 
 
 
 
 
The sizes do not really matter as long as there are a few stars 
within the pentagon. 
 
 
 

 
 

• Select Vector Clipping.  
 
 
 
The vector clipping form appears with instruction on how to use the 
command and the different results available with the options given. 
 
• Select the Polygon and then shift – select all of the 

other vectors (can drag a box). 
 
• Select Clipping Direction as Inside and Overlapping 

Vectors as Trim. 
 
• Select Clip Vectors. 
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The stars that are whole within the polygon are retained 
and those that cross the polygon are trimmed back as 
shown. 
 
 
 
 
 

 

Vector Slicing Exercise 
 
• In a New Model of size 100 x 100 and Origin at the centre sketch the 

following vectors. 
 

 
 
• Shift - Select both the closed vectors followed by the open (slicing) vector. 

• Select Slice Selected Vectors.  
 

 
 
 
 
 
 
The Vector Slice page appears displaying the options available. 
The Use last selected vector option is only available when 
more than one vector is selected. Otherwise it will be greyed 
out. 
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• Select the options Close and Use last selected vector. 
• Select Slice Vectors. 
• Nudge the two new vectors up and down using the keyboard up and 

down arrow keys to see the result. 
 

 
 
 
 
 
The vectors have been sliced and rejoined. 
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4. Bitmaps 

Introduction  
 
 
Coloured Pictures can be generated or edited within ArtCAM using the Bitmap toolbar. 
Bitmaps can be loaded in using any of the following formats bmp, .tif, .pcx, .gif, and .jpg 
and .pdf.  
 
 
ArtCAM can also generate vectors of the boundaries of the selected colour and the ability to 
link colours together temporarily which enables you to define different areas without 
changing the original picture. This is called Colour Linking. 
 

Bitmaps are loaded directly into ArtCAM by using File – Open  or 
importing the image (onto a new layer) from the Bitmap layers tab.  
 

 
 
The following exercise illustrates the above functionality on two examples. 
 

Bitmap to Vector – Exercise 1 
 

• Select New Model.  
• Enter a Height of 200mm, a Width of 200mm and a Thickness of 12mm. 
• Set the Origin to the bottom left and both Z Zero and Model Position at 
the Top Of Block.  
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• Activate the Bitmap Layers fly out panel if not 

already visible. 
 
 
 
• Select Import Image  to display the Load 

Bitmap Layer Dialogue Box. 
 
• Locate the file Art.bmp from: D:\users\training\ArtCAM Data. 
 
• Still within the dialogue box, Expand the Scaling list and select Fit.  
 

 
 
 
• Select Open to load / Import the Bitmap.  
 

 

 
 
 
The Bitmap is loaded onto its own Bitmap Layer. All associated colours with this Bitmap 
are displayed in the Pallette. 
 
The Colours will be reduced to assist and accelerate with the Vectorization process. 
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• Activate the Assistant Tab and Select Reduce Number 

 from the Bitmap Tools area. 
 
 
(Or from the Main menu Bitmaps>Colour>Reduce Number) 
 

 
 
• Enter 5 for a New Maximum number of colours For Image. 
• Select OK. 

 
 
A message box is displayed warning that reducing the 
number of colours in the bitmap image will reset all colour 
links and attributes. 
 
 
• Select Yes. (as there are no current links in this case) 
 
 
• Select OK 
 
 
ArtCAM takes all the colours of a similar shade and 
produces a new average of only 5 colours. These are now 
shown in the palette. 
 
 
 

Upon close inspection the grey colour  can be seen as a thin 
border around the letters. 
 
This will be eliminated by colour linking. 
 
 
 
 
 
• With the left mouse button, select the white colour (third from left) in the 

palette to make it a primary colour. 
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• Double right mouse click on the grey colour (fourth from left) to link it to 

the primary colour. 
 
 
 
 
 
 
All previous grey pixels have changed to the primary colour of 
white. 
 
 
 
 
• From the Vector creation toolbar at the top of the screen (or assistant tab) 

select Bitmap to Vector.  
 
 

• Enter a Pixel Tolerance of 1, select the option 
Keep Lines and enter a Min Pixel Length of 3 
and select Create Boundary.  

 
• Select Create Vectors and close the form. 
 
 
 
 
• Toggle Bitmap visibility  in the Bitmap Layers 

Tab to hide the original image. 
 
 
 
 
 
 
 
 
The Vectors are generated around the primary colour (in 
this case White) 
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Bitmap to Vector – Exercise 2 
 
 
 

• Select Open Model.  
• Select the folder: D:\users\training\ArtCAM Data, and change Files of 

type: to Bitmap Files. 
• Select the file toucan.gif, followed by Open. 
• Leave the Set Model Size dimensions as default, and select OK. 
• Left mouse click on the first green colour in the colour palette (make 

primary) 
 

 
 

• Double right mouse click on the next 5 green colours (to link to primary) 
• Double right mouse click on the red and yellow colours. 
 

 
 
The toucan is now surrounded by a single green 
colour. 
 
For the body part of the toucan, the feet and the red 
beak are not required, so they were also linked to the 
green.  
 
A single vector from the boundary of the Primary 
colour will now be created. 
 
 

 
• From the Vector creation toolbar at the top of the screen (or assistant tab) 

select Bitmap to Vector.  
 
 

• Enter a Pixel Tolerance of 1, select the option 
Keep Lines and enter a Min Pixel Length of 5 
and select Create Boundary.  

• Select Create Vectors and close the form. 
• Toggle Bitmap visibility  in the Bitmap 

Layers Tab to hide the Toucan image.  
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A single closed vector has been generated on the primary 
colour(s) boundary. Adjusting the pixel tolerance will 
define how close the vector will follow the primary colour 
boundary.   
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5. The Toolpath Options 

Intoduction 
 
ArtCAM can produce a variety of machining strategies directly from vectors or on an 
imported 3D Relief.  The machining set up and strategy commands are accessed from the 
Toolpaths tab in the Project tree or by activating the Toolpath’s fly out panel. The toolpaths 
that are generated are stored within the ArtCAM model and can easily be edited. To drive a 
specific machine tool one or more toolpaths are output as a post-processed file translated to 
the format of the relevant controller. 

 

Toolpaths page 
 
The Toolpaths page is segregated into four main categories - Toolpath Operations, 2D 
Toolpaths, 3D Toolpaths and Toolpath Simulation. 
 

 
 
When a Toolpath is calculated it will be displayed in this 
upper area of the Toolpaths page. The Toolpath Names can 
be selected for Toolpath Simulation, Toolpath Operations 
or to re-opened for editing. 
 
 
 
 
The Toolpath Operations area contain operation including 
Save (to post process), Delete, Tool Database, Material setup 
and creating machining templates. 
 
 
The 2D Toolpaths section contains commands to generate 2D 
Toolpaths directly from Vectors including Profiling, Area 
clearance, Bevel and V-bit Carving, Inlays and Texture 
toolpath. 
 
The 3D Toolpath section contains commands to generate the 
toolpaths over an imported 3D Relief. 
 
The Toolpath Simulation section provides controls for 
viewing Toolpath animation and material removal. 
 
Toolpath Parameters allows changes made to the selected 
Toolpath Parameters such as Tool number. 
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It may be required to modify the origin of the model to a position more appropriate as a 
machining origin. This is achieved by inputting suitable X Y Z values in the 
 
 

 Set Model Position dialog box.  
 

 
 
This can be accessed from the top drop down menu Model > Set position. 
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6. 2D Vector Machining 

Introduction 
 
ArtCAM Insignia has a series of powerful options to create 2D Toolpaths that are directly 
calculated from vectors.  

Forest Sign – 2D Area Clearance 
 
• Open the model Forest_Sign.art from: D:\users\training\ArtCAM Data. 
 
 

 
 
• Hold down the shift key and multi-select the Inner Ellipse, Squirrel, 
Tree, and Text vectors. 
 
 
• Activate the Toolpaths fly out panel if not already 

visible. 
 

• Select Area Clearance Toolpath  from the 2D Toolpaths Tab. 
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• Set the Start Depth as 0, Finish Depth as 
2mm and Allowance as 0. 
 
• Set the Final Tool Allowance as 0.25mm and 
Tolerance as 0.01mm. 
 
 
• Select the downward arrow under Machine 
Safe Z and enter a value of 20mm for Safe Z and 
X-100, Y-50 and Z20 for the Home Position. 
 
 
 
 
 
 
The following information was entered: 
 
Start Depth – is the height from where the Stepdown is calculated. 
 
Finish Depth – is the maximum depth for machining to occur. 
 
 
 
Allowance – is the amount of 2D stock remaining on 
the vectors for the final tool.  
 
The Material Allowance is the specified thickness of 
material that is left on over the actual relief when the 
toolpath is created. 
 
 
Final Tool Allowance – is the amount of 2D stock remaining for all except the final tool 
(normally used to produce a better surface finish) 
 
 
 
Tolerance – the toolpath will create a finish to within 0.01 the original vector. 
 
 
Tolerance determines how accurately a cutter path 
follows the true shape of the vector or relief, the 
actual value being the maximum permissible deviation 
from the form.  
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Safe Z – is the height at which rapid moves across the component 
are permitted. 
 
Home Position: specifies the coordinates of the Start and End 
point of the toolpath. 
 
 
 
•  Select Add from the Tools List to launch the Tool Database. 
 

 
The default Tool Database contains a large 
selection of tools and associated parameters for 
a variety of materials. The selection can be 
modified, deleted, or added to by the user as 
required. 
 
You can also have access to the Tool Database 

by selecting the icon  in the Toolpath 
Operations Tab. 
 

 
 
 
• By selecting the  sign next to the names, 

Browse to Metric Tools > Wood or Plastic 
> Roughing and 2D Finishing > 

  
• Select the End Mill 6mm. 
 
 

 
When a tool is selected (highlighted) in the left 
hand window, the tool data and description is 
displayed on the right-hand side of the form.  
 
Individual tools can be Editied, Deleted or 
Copied.  
 
New Groups and Tools can also be created for 
customisation. 
 
 

 
 
• Press Select on the form to accept the 6mm End Mill as the Roughing 

operation tool. 
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The 6mm End Mill tool and its parameters are now loaded into the Tools List. 
 
 

 
 

• Select the down arrow  to reveal the default settings for the selected 
tool. 

 
 
The default tool parameters (for Wood and Plastic 
6mm End Mill) are shown. Changing values in this form 
do no affect the original tool stored in the database. 
 
The Stepover is the distance between passes. 
  
The Stepdown is the incremental depth of cut (slices). 
 
A Tool number is essential if outputting to a machine 
tool fitted with an automatic tool changer. 
 

 
 
• Select Add from the Tools List to launch the Tool Database. 
 
• From the tool database Wood or Plastic > Roughing and 2D Finishing 
area and load in the End Mill 1.5mm tools. 
 
 
 
The 2D Area Clearance strategy allows multiple tools to be selected.  
 

 
The selected tools are displayed. The adjacent 
arrows can be used to change the sequence if 
required.  
 

 
The Tools List contains two different End Mills. When the toolpath is calculated, the larger 
6mm End Mill is used first to perform the main 2D Area Clearance machining. Any 
subsequent, smaller tools in the Tools List will only operate locally in areas that are out of 
reach to the previous tool (i.e. Rest Milling). 
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There are two options available for 2D Area Clearance machining strategies, Raster which 
steps a linear cutterpath backwards and forwards across the component or Offset which 
steps the cutterpath parallel to the selected vector(s).  
 

Raster Strategy   
 

 
With the Raster strategy, the tool moves across 
the Z Slices in parallel, straight line moves 
separated by the Stepover distance. The 
toolpath is automatically limited away from the 
relief / Vector by the tool radius plus the 
Material Allowance, as shown. 
 

 

Offset Strategy 
 

 
With the Offset strategy, the tool moves are 
offset inwards from the shape of the Complete 
Relief or limiting Vector, and outwards from 
the shape of the Relief / Vector contour. 
Individual tracks are separated by the Step over 
distance. 
 
 

 
 
 
• Select a Raster strategy for both tools and leave the Raster angle at 0 
(X=0). 
 
• Leave the Independent Finish Depth options unticked. 
 
This allows the option to specify an Independent depth for a particular tool.  
 
 
 
• Set up the Material to have a Thickness of 
10mm, the Z Zero at the top, and Model 
Position at the bottom. 
 
• Enter the Name EM6EM1_5-AreaClear. 
 
• Select Calculate Now. 
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The 2D Area Clearance toolpaths will appear as shown above. As the primary tool (End 
Mill 6mm) had a default Stepdown value of 2.4mm, all of the machining has been 
performed at the single depth of –2mm. If the above Stepdown value were 1mm then the 
machining would have been performed at depths of both –1mm and –2mm. 
 
• Close  the 2D Area clearance form. 
 
The Toolpaths are listed in Toolpaths fly out panel. 
 
 

 
The Toolpaths window now contains two named 
toolpaths, which by default are also displayed in both 
the 2D and 3D views – by using the check boxes. 
 

• In the 3D view, select the Isometric View.  
 
  

 
The generated Toolpath components are 
colour coded to assist with both 
visualisation and identification for post-
processing.  
 
Cutting Feed Rate moves are Red, Safe Z 
rapid moves are Dark Blue, and 
Plunge/Ramp moves are Pale Blue. 
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The Toolpath appears at the top of the Toolpaths 
page. The Toolpath can be shown or hidden by 
ticking or unticking the relevant Show in – 2D/3D 
column boxes. 
 

 
 

The Objects to Draw icon  at the top of the 3D View, allows the user to toggle the 
visibility of all entity types (not just machining toolpaths).  
 
• Click Objects To Draw  on the 3D View Toolbar. 
 

 
You can toggle between different objects by clicking on them 
and by selecting Apply to display the selected items in the 3D 
View. Currently, only the Vectors are undrawn. 
 
 

 

Simulating the Toolpaths. 
 
Toolpath movement and material removal can be simulated in the ArtCAM 3D View. 
Options are available in the Toolpath Simulation Tab at the bottom of the Toolpaths fly 
out menu. 

  
Options available in this menu are simulate, reset 
and delete.  
 
The shading can also be changed to reflect the 
final material. 
 

 

• Select Simulation Control bar  from Toolpath Simulation. 
 
The following form will be displayed: 

 
 
Relief Dimensions: shows the overall dimensions of the relief. 
Simulation Block Dimensions: gives the size of the block. 
This should be at least as big as the minimum and maximum 
height of the relief plus any height (or depth) of the engraving 
features.  
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Simulation Relief Resolution: specifies the quality of the image that you require. The lower 
the resolution, the greater the speed of calculation. 
 

• Select Simulate Toolpath.  
 

 
With this option the highlighted tool is drawn 
(End Mill 6mm first), along with a control panel 
to control the speed of the simulation. 
 

For example, Selecting  will simulate at 
normal cutting speed. 
 
 

 
 

• In this case, select Play Simulation at Fast speed.  
 
 
 
 

 
The End Mill 6 mm is simulated. 
 
This toolpath has machined the inner form 
leaving a 2D stock of 0.25mm to be finished by 
the End Mill 1.5mm toolpath. 
 
 
 
 

 

• Select Play Simulation at Fast speed.  
 

 
 
 
 
The End Mill 1.5 mm toolpath has 
successfully rest machined the remaining areas 
inaccessible to the previous cutter and removed 
the final 0.25mm stock allowance. 
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Forest Sign – 2D Profiling 
 
 
 
• Select the 2D View and 
select the Outer Ellipse vector. 
 
 
 
 
 
 
 
A 2D Profiling strategy will be used to drive the tool around the outside of the sign. 
 
 
 

• Select Create Profile Toolpath  from the 2D Toolpaths Tab. 
 
 

 
A Profiling toolpath can be generated to the defined depth, on 
the Inside, Outside or Along a closed vector. There is also the 
option to apply a Climb Mill or Conventional direction of cut. 
For an open vector, Inside will offset the toolpath to the right 
of the vector direction whereas Outside will offset the 
toolpath to the left of the vector direction. 
 
The depth of cut for each profiling pass is defined by the 
tool’s stored parameters, for example if the tool has a step 
down of 2mm maximum, it would take 5 profiling passes to get 
down to a total depth of 10mm. 
 
With a 2D Profiling toolpath the option is available to 
approach required profile with a horizontal, arc Lead In and 
Lead Out. This would result in a tool plunge move occurring 
away from the profile followed by a smooth, tangential 
transition onto the actual tool track.  
 
 
 
 
 

 
 
• Select Profile side as Outside. 
 
Offset Allowance specifies an offset distance to the vector. 
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Final Pass Thickness allows a ‘skin’ of material removed only on the last pass.  
Final Pass Allowance as above leaves a skin of material but in the Z 
Height only. Also is removed on the last pass. 
 
 
• Leave the above settings as zero including the Offset Allowance. 
 
 
• Select a Start Depth of 0, Finish Depth of 10 and a Tolerance of 
0.01mm. 
 
• In Profiling Tool, select the Select button and load in the same 6mm End 
Mill that was used earlier in the 2D Area Clearance operation. 
 
 
 
The cut direction of the tool can be selected here from either Conventional or Climb 
Milling. 
 
When 2D Profiling around a component, a superior finish is achieved for most materials if 
the direction of travel is the left of the vector (Climb Milling). There are however a few 
materials (certain plastics) where a superior finish is achieved if the direction of travel is the 
right of the vector (Conventional).  
 
 

 
 
 
In Conventional Milling, the teeth of the tool meet the block of material at the bottom of the 
block. With this action, the teeth of the tool slide along until sufficient pressure builds up to 
break through the material surface. 
 
In Climb Milling, the teeth of the tool meet the block of material of material at the top of the 
cut, at the thickest part of the cut.   
 
Climb milling often provides a better finish, permits greater tool feed rates and prolongs the 
life of the tool. 
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• Select Climb at the Cutting direction. 
 
• Leave the same (as before) Material Thickness, Safe Z, and Home 
position. 
 
• Enter the Name EM6Profile. 
 
• Select Calculate Now. 
 
 
 
 
 
The 2D Profiling toolpath has been 
generated outside the Outer Ellipse. 
 
 
 
 
 
• Close the Profiling form. 

• Select Simulate Toolpath.  
 

 
 
 
The simulation steps the 2D Profiling pass 
down to a total depth of 10mm. If it is 
required to keep the sign attached to the outer 
material then location lugs (Bridges) can be 
applied retrospectively along the toolpath.  
 
This will be shown next. 
 

 
 
 
• Select File - Save As TrainForestSign.art in: 
D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 

 
• Do not close the model. 
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• Select Profile Options  from 2D Toolpaths. 
 
• Expand the Bridges Tab and enter the following 
settings. 
 
• Select Constant Number from Add Bridges to 

Profiles. 
 
• Enter Number 4. 
 
• Enter a Thickness of 3mm and Length of 4mm. 
 
• Tick the option for 3D bridges and then Create Bridges tab to create 
them. 
 
 
Bridges can be manually dragged (dragging centre circle) or increased in 
width by dragging the end square. 
 
 
• Close the Profile Options form and switch to the 3D view. 
 

• Select Reset Simulation  and Simulate All Toolpaths  to view 
the added bridges. 
 
 

 
 
Further 2D machining strategies will be applied to this example. 
                                                                                                    
• Do not close the model. 
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Bevel Carving 
 
 
The 2mm high text ‘FOREST’ on the sign will have a 1mm chamfer added by using the 2D 
Toolpaths option called Bevel Carving.  
The process requires the user to input a Bevel Carving Tool. The tool dimensions and/or 
stored values of Stepdown and Stepover will determine if the chamfer is machined as a 
series of ‘stepped passes’ or in a single ‘pass’ 
 
 
 
 
• In the 2D View select the Text item 
‘FOREST’. 
 
(Note: View shown is with toolpaths switched 
off) 
 
 

• Select Bevel Carving  from the 2D Toolpaths Tab. 
 
 
 
• Enter a Start Depth 0, Bevel Max Depth 1, 
Finish Depth 2mm. 
 
Bevel Depth is the max depth the carving tool will reach. 
Wall height is the height of the profiled part of the carving 
which is zero, if no profiling tool is selected. 
Finish depth is entire depth of the whole cutting operation 
 
• Enter Allowance of 0 and a Tolerance of 
0.01mm. 
 
• Enter a Safe Z of 20 and a Home Position of  
X-100 Y-50 Z20. 
 
• Select Centreline. 
  
This determines the max width of path to engrave. 
 
• Select a V-Bit 32mm 120 degrees Carving 
Tool and a 1.5mm End Mill Profiling Tool. 
 
• Set a Climb Mill Cut Direction. 
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• Set up the Material to have a Thickness of 10, the Z Zero should be at 
the top. 
 
• Enter a Name as Bevel_Carving. 
 
• Select Calculate Now. 
 
 

 
 
 
The toolpaths can be seen in the 3D view.  
 
Note: view is shown with other toolpaths 
switched off. 
 
 
 
 
 
 
 
 

 
• Close the Bevel Carving form. 
 

• Select Simulate All Toolpaths.  
 
 

 
 
The 1mm chamfer can clearly be seen on 
the embossed 2mm high text. 
 
 
 
 
 
 
 
 

 
 
• Select File - Save to update the model saved earlier. 
 
• Select File - Close Model 
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V Bit Carving 
 
The following example illustrates the V-Bit Carving strategy. 
 
• Select Create New Model and Enter a Width and Height of 100mm. 
• Set the resolution to 2004 x 2004 points and origin in the centre. 
 
• From the top pull down menu, Select Vectors - Import and Open the file:  
 
D:\users\training\ArtCAM Data\V-BitCarvingVectors.eps 
 
 
 
 
 
 
 
 
 
 
 

• Ungroup  (or Ctrl+U) and then select the Vectors.   
 

• Select V-Bit Carving  from the 2D Toolpaths Tab. 
 
• Leave the Start Depth as 0. 
• Ensure Tolerance is set as 0.01.  
 
The maximum permissible depth for machining to occur can be 
set by selecting Limit tool maximum depth and specify a 
Maximum Depth value. 
 
• Select a V-Bit 32mm 90degrees Carving Tool 
from Wood or Plastic – V-Carving, and change the 
Stepover to 1mm and Stepdown to 3mm. 
 
• Set the Safe Z as 20mm and the Home Position 
as X-100 Y-50 Z20.  
• Enter a Material Thickness of 20mm and set the 
Material Z Zero is at the top of the block. 
• Enter a Name of VBitCarving and select Calculate 
Now. 
• Do not Close the form. 
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• Simulate  the calculated Toolpath. 
 
 

 
 
 
The toolpath is calculated creating ‘V’ shaped 
recesses inside or between pairs of selected 
vectors and text. The maximum depth of the 
recesses is currently unlimited but the tool does 
perform an area clearance at incremental depths 
equal to the specified Tool Stepdown value. 
The Area Clearance can be removed by 
inputting a suitably high value for Stepdown. 
 
 
 

 
 
• Edit the Tool Stepdown to 10mm.    
• Calculate the Toolpath again. 
•  Do not Close the page. 

 
 
 
 
The toolpath has created the same end result, 
but without performing area clearance at 3mm 
incremental depths (the tool Stepdown is now 
10mm). 
 
 
 
 
 

 
 
 
• Select File - Save As and save the model with the File name VbitCarving 
in: 
 
D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 
 
• Select File – Close Model. 
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7. 3D Machining 

Introduction 
 
ArtCAM Insignia allows Raster machining of Imported 3D Models (Reliefs). Toolpaths 
are generated within the imported ArtCAM model and then a copy is saved out in the 
required machine tool format. A 3D model can be imported in two ways. 
 
 

1. Directly from Paste a Relief from a file.   
 
 
2. Converted from an imported 3D model.   

 
 

Toolpath Generation for a Pasted Relief 
 

• Select Create New Model.  
• Enter a Width of 50mm, a Height of 50mm and a Thickness of 10mm. 
• Set the Material Z Zero at the top of the block and Model position on 

the Machine bed. 
• Set the Origin in the centre of the block diagram.  
 

 
 
• Select OK to accept the settings 
 
 
The 3D Relief will now be imported into the model using the Relief Creation Toolbar.  
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• Select Paste Relief From A File.  
 
 
 
 
• Select Load and locate the file ted.rlf 

from: D:\users\training\ArtCAM Data. 
 

 
 
 
 

 
 

 
 
 
 

The size of the Relief is shown in the 3D view. 
 
At this stage, the size can be altered and 
positioned to requirements. 

 
 
 
 

 
 
 

 
• Select Paste and then Close the 

form. 
 
 
 
 
This Relief will be machined using two Toolpaths - An Initial Roughing pass followed by a 
Finishing Toolpath. 
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• From the 3D Toolpaths area, select Machine Relief.   
 
 
The Machine Relief page appears. 
 
 
The Machine Relief form allows Roughing and/or Finishing operations (depending on tool 
selected) to be defined here.  
 
The basic areas are summarised below but will be discussed in greater detail at each stage. 
 

 
 
Area To Machine – this either applies to the Relief or 
area within the Selected Vector. 
 
 
Finishing Options – allows the Finishing tool, cutting 
strategy and angle to be defined here.  
 
Roughing Options – allows the Roughing tool, cutting 
strategy and angle to be defined here. The Z slices 
(thickness of each cut) is also defined here. 
 
Lead In Moves – For harder materials, this option is used 
to apply a ramping move of the tool into the material 
instead of the default vertical plunge. 
 
Safe Z, Home – Sets the safe Z height (rapid move) and 
Start/End position of the tool. 
 
Material Thickness – This can be defined here or as 
shown from the initial job setup. 
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• Select the Area to Machine as Whole Relief.  
 
Note: Whole Relief defines the complete model page and not just the Relief itself. 
Machining can be restricted by using the alternative option of Selected Vector.  
 
 
• Change the Tolerance to 0.01 
 

 
Tolerance determines how accurately a cutter path 
follows the true shape of the relief, the actual value 
being the maximum permissible deviation from the 
relief form.  
 
 
 

 
 

• In Finishing Options, select  to launch the Tool Database. 
 
 

 
The default Tool Database contains a large 
selection of tools and associated parameters for 
a variety of materials. The selection can be 
modified, deleted, or added to by the user as 
required. 
 
You can also have access to the Tool Database 

by selecting the icon  in the Toolpath 
Operations Tab. 
 

 
 
 
• By selecting the  sign next to the names, 

Browse to Metric Tools > Aluminium > 3D 
Finishing > 
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• Select the Ball nose 3mm. 
 

 
When a tool is selected (highlighted) in the 
left hand window, the tool data and 
description is displayed on the right-hand side 
of the form.  
 
Individual tools can be Editied, Deleted or 
Copied.  
 
New Groups and Tools can also be created 
for customisation. 
 

 
 
 
• Press Select on the form to accept the 3mm Ball Nose as the finishing 

operation tool. 
 
 
 
 
 
The 3mm Ball nose tool and its parameters are now loaded into the Machine Relief form. 
 
 

 
 

• Select the down arrow  to reveal the default settings for the selected 
tool. 

 
 
 
The default tool parameters (for Aluminium 3mm 
Ball Nose) are shown. Changing values in this form 
do no affect the original tool stored in the database. 
 
The Stepover is the distance between passes. 
  
The Stepdown is the incremental depth of cut (slices). 
 
A Tool number is essential if outputting to a machine 
tool fitted with an automatic tool changer. 
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• Change the Stepover to 0.5mm. 
 
• Leave the Stepdown as the default 1.2mm. 
 
• Ensure the Raster in X strategy is selected  
 
• Ensure the Allowance is set to 0mm. 
 
 

 
The Material Allowance is the specified thickness of 
material that is left on over the actual relief when the 
toolpath is created. 
 
 

So based on the above value of 0mm, no material will remain on the relief after machining 
has completed.  
 
 
The Roughing Tool (first operation) will now be defined. 
 
 
Roughing will remove the excess material from around the Relief up to the specified 
Material Allowance and Tolerance values. For efficiency, a relatively large tool is generally 
used for this operation. Roughing splits the Material into Z Slices and performs the selected 
Area Clearance strategy (Raster or Offset) on each one. 
 
 
 

• In Roughing Options, select  to launch the Tool Database. 
  
 
 
• Browse Metric tools, Aluminium, Roughing and 

2D Finishing and then select End Mill 6mm. 
 
• Select the tool. 
 
• Select the down arrow  on the End Mill 6mm bar. 
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As before, the Feed Rate, Plunge Rate and Spindle 
Speed are based on the tool manufacturer 
recommendations but can be adjusted to suit the 
machine tool, and material used and how rigidly it is 
clamped down.  
 
A unique Tool Number value must be input if the 
toolpath is for a machine tool with an automatic tool 
changer. If not, the value can be left as 1. 
 
 
 
 
 
 
 

 
 
 
• Change the Stepover to 4mm. 
• Change the Stepdown to 2mm (this will be used for calculating the Z 

Slices). 
• As before, leave the default Feed Rate at 20mm/sec, Plunge Rate at 

6mm/sec, Spindle at 15000 r.p.m, and Tool Number as 1. 
 
 
 
• Select Apply in the Z slices area 
 
 
On clicking the Apply the number of Z slices (depth of 
each cut) is automatically calculated. The automatic 
figure of 5 slices each at 1.898mm, was calculated 
from the tool Stepdown (set as 2mm), Distance to 
bottom offset and Allowance. 
 
 
Start/Surface Z at 0 (this is the initial height from where the first Step Down value will be 
subtracted). 
The Last Slice Z at -9.49 defaults to the height of the Material Allowance above Relief base 
level. This value can be modified upwards to leave more material on the base level if 
required. 
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These values can be customised to suit (e.g if a thicker base is required) by altering the Tool 
Stepdown value, Material thickness, or by unticking the  box and entering 
suitable settings. 
 
• Leave the values as calculated automatically. 
 
 
The next stage is to select a suitable Strategy from either 
Raster or Offset. 

 

Raster Roughing   
 

 
With the Raster strategy, the tool moves across 
the Z Slices in parallel, straight line moves 
separated by the Stepover distance. The 
toolpath is automatically limited away from the 
relief by the tool radius plus the Material 
Allowance, as shown. 
 

 
 
 
The Raster process on its own tends to leave 
steps around the Relief. If required these can be 
removed by applying a Profile Pass either 
before (First) or after (Last) the Raster moves. 
 
 

Offset Roughing 
 

 
With the Offset strategy, the tool moves are 
offset inwards from the shape of the Complete 
Relief or limiting Vector, and outwards from 
the shape of the Relief contour. Individual 
tracks are separated by the Step over distance. 
 
 
 

 
• Ensure the Raster strategy is selected with an angle of 0 degrees. 
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Selecting a profile will Add a profile ‘clean up’ pass either before, during 
or after each Z slice is machined. In this example the Z Slices will be 
machined using a Raster strategy without the addition of a Profile Pass. 
 
• Do not select a Profile Pass. 
 
 
The default Angle: 0 (along X) for the Raster strategy can be changed if required. 
 
 
The Cutting direction of the tool can be selected here from either Conventional or Climb 
Milling. 
 

 
 
In Conventional Milling, the teeth of the tool meet the block of material at the bottom of the 
block. With this action, the teeth of the tool slide along until sufficient pressure builds up to 
break through the material surface. 
 
In Climb Milling, the teeth of the tool meet the block of material of material at the top of the 
cut, at the thickest part of the cut.   
 
Climb milling often provides a better finish, permits greater tool feed rates and prolongs the 
life of the tool. 
 
• Leave the cutting direction as both. 
 
• Ensure the Allowance is 0.5mm.  
 
 
 
This will leave 0.5mm of material after machining. The finishing tool will then remove this 
allowance down to zero for the final finishing strategy. 
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• Leave Add Ramping Moves unticked.  
 
 
 
Ramping Moves are applied to avoid plunging, especially where harder materials are being 
machined. If Add Ramping Moves the user has access to a selection of ramping options to 
control the Angle, Length, and incremental Height of ramp moves. 
 
 
• Select the down arrow  on the Machine Safe Z and Home bar. 
• Set Safe Z at 15 and the Home Position as X0 Y0 Z15. 
 
 
 

 
 
 
 
 
Safe Z is the user defined height in Z above the material where the tool can safely perform 
rapid moves to and from plunge positions.  
 
Note: do not forget to consider the heights of clamping and fixture components, if applicable. 
The tool Home Position defines the Start (1st move) and End (last move) of the toolpath. It 
is not permitted for the selected Z value that is less than the Safe Z value. 
 
 
• The Material has already been defined hence there is no need to open 

Setup.  
 
• Enter the name for the Toolpath as Relief Machining. 
 
• Select Calculate Now to commence the toolpath calculation. 
 

 
The Toolpath can be calculated Now or Later. 
When the option Later is chosen it will save the 
uncalculated toolpath until the Batch Calculate 
option is selected from the toolpaths menu. 

 
 
Several unprocessed Toolpaths could be Batched ready to be calculated at a later time.  
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During calculation, a progress bar will show the current 
percentage completed. 
 
 
 
• Upon completion, close the machine Relief form  
 
The 3D view, illustrates the calculated cutter paths. 
 
 

 
 
 
The generated Toolpath components are 
colour coded to assist with both 
visualisation and identification for post-
processing.  
 
Cutting Feed Rate moves are Red, Safe Z 
rapid moves are Dark Blue, and 
Plunge/Ramp moves are Pale Blue. 
 
 
 

 
 

 
The Toolpath appears at the top of the 
Toolpaths page. The Toolpath can be shown or 
hidden by selecting the relevant bulb icons. 
 
 

 
 

The Objects to Draw icon  at the top of the 3D View, allows the user to toggle the 
visibility of all entity types (not just machining toolpaths).  
 
• Click Objects To Draw  on the 3D View Toolbar. 

 
 
You can toggle between different objects by clicking on 
them and by selecting Apply to display the selected items 
in the 3D View. Currently, only the Vectors are undrawn. 
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• Highlight only the End Mill 6mm Roughing toolpath and select Apply. 
 
 

 
 
 
The Initial Roughing Toolpath is now the only 
displayed item. 
 
 
 
 
 
 

 
 
 
 
• Highlight only the Ball Nose 3mm Finishing toolpath and select Apply. 
 

 
 
The Finishing Toolpath is now displayed. 
 
 
 
 
 
 
 

 
 
• Highlight all objects as before, followed by Apply. 
• Select File and then Save.  
 
 
 
The Toolpaths have been saved into the current 
ArtCAM model. 
 
 
 
If the Toolpaths require Editing, double left mouse clicking on the toolpath in the Toolpaths 
window will reopen the Machine Relief form.  
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Any parameter can be changed and recalculated to update. Note: if a new, separate 
Toolpath is required, edit the Name to be different from the original. 
 
 
Certain parameters can also be quickly changed by highlighting the 
individual toolpath and then selecting Toolpath Parameters at the 
bottom of the Toolpaths fly out menu. Select Apply to update. 
 
 
 
 

Simulating the Toolpaths 
 
Toolpath movement and material removal can be simulated in the ArtCAM 3D View. 
Options are available in the Toolpath Simulation Tab at the bottom of the Toolpaths fly 
out menu. 
  

 
Options available in this menu are simulate, reset, 
delete, export and import the simulation.  
 
The shading can also be changed to reflect the final 
material. 
 

 
• Select and Highlight the Relief Machining Toolpath. 
 

If Simulate Toolpath is selected,  all individual Toolpaths (within the Toolpath) will 
be simulated in sequence.  

• Select Simulate Toolpath.  
 

 
The following form will be displayed: 
 
Relief Dimensions: shows the overall dimensions of the 
relief. 
Simulation Block Dimensions: gives the size of the block. 
This should be at least as big as the minimum and 
maximum height of the relief plus any height (or depth) of 
the engraving features.  
Simulation Relief Resolution: specifies the quality of the 
image that you require. The lower the resolution, the 
greater the speed of calculation. 
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• Select Standard from the Simulation Relief Resolution area. 
• Use the other default settings and select Simulate Toolpath. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The two toolpaths in the sequence listed are simulated on screen and the final result shown 
(after finishing operation) 
 

• Select Reset Simulation to reset the block.  
 
The toolpaths will be simulated individually to verify the results after each stage. 
 
 
• Select and Highlight the Machine Relief Toolpath. 
 

• Select Simulation Control bar.   
 
 

 
 
With this option the highlighted tool is drawn 
(End Mill 6mm first), along with a control panel 
to control the speed of the simulation. 
 

For example, Selecting  will simulate at 
normal cutting speed. 
 
 

 
 
 

• In this case, select Run at Max speed to next retract.  
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The simulation stops (and retracts) at the end 
of the first Toolpath End Mill 6mm 
Roughing. 
 
 
 
 
 
 

 

• Select Run at Max speed to next retract  again. 
 
 

 
 
 
 
The simulation ends at the final toolpath 
Ball Nose 3mm Finishing. 
 
 
 
 
 

 
 
 
The result is a 3D model of the part machined component which also within graphics 
limitations will indicate the standard of surface finish.   
 
 
The calculated toolpaths are ready to be post processed (saved). This is explained in the next 
chapter. 
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8. Post Processing Toolpaths 

Introduction 
 
The Toolpaths produced in ArtCAM have to be translated into a different format as an 
exported file for a specific machine tool controller. The collective name for one of these 
files is NC data and the operation is called Post-Processing which is accessed via the Save 

Toolpaths option in the Toolpaths Tab.  

 

Post Processing of Toolpaths for a Manual Tool Changer 
 
 
• Open the previously machined model. training-savannah.art 
D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 
 
• Activate the Toolpaths fly out panel if not already visible. 

 
 
 
All toolpaths previously calculated are listed. 
 
Use the scroll bar to view all. 
 
 
 
 
 

 

• Select Save Toolpaths  from the Toolpath Operations area. 
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When the Save Toolpaths form is opened all existing toolpaths are listed in the left hand 
window. Toolpaths are selected and transferred from one side to the other using the central 
Arrow buttons. 
 
                                                              
All the files in the right hand window will be included for output into a single NC data file.  
If the machine tool uses a manual tool changer then it will only be possible to include 
Toolpaths in the NCdata file that share the same cutting tool. If the machine tool has an 
automatic tool changer then any combination of the available toolpaths can be include in 
the NCdata file. (as long as the selected machine supports it) 
 
 
• Select the toolpath Inlay Pocket – End Mill 3mm and then the right Black 

arrow.  (to transfer it across) 
• Deselect Save files to spool Directory (You will be prompted for the 

location directory for outputting the current NCdata file). 
 
• From Machine Output, select Axyz_Arc_MM(*.nc)  
 

 
 
 
Note: this machine does not 
support an automatic tool 
changer hence only Toolpaths 
that use the same tool can be 
included in the ncdata output 
file. 
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• Select Save and browse to select C:\temp, enter a File name as Em3-

Inlay Pocket -Savannah and select Save. 

• Select the left black arrow  (to move the toolpath back to the left 
window).  

• Select the toolpath Inlay Pocket End Mill 1.5mm and then the right Black 

arrow.   
 
• Select Save and browse to select C:\temp, enter a File name as Em1.5-

Inlay Pocket -Savannah and select save. 
 
• Repeat the above procedure for the remaining Toolpaths providing 

suitable file names. 
 
• Browse to the C:\Temp directory to see the saves toolpaths. 
 
 

 
  
 
All the post-processed Toolpaths have been saved outside ArtCAM and translated in the 
format required for an Axyz machine controller. These files can now transferred to the 
machine controller itself, ready for manufacture. 
 
Note: If the Toolpath is modified within ArtCAM, the above process must be repeated for 
that specific file. 
 
• Do not close the model as it is required again in the next chapter. 
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Post Processing of Toolpaths for an Automatic Tool Changer 
 
 
If a Machine Tool is fitted with an Automatic Tool Changer then the control of this feature 
will be available in the Post Processor translation. 
 
If toolpaths containing different tools are passed over to the right hand window of the Save 
Toolpaths form and the selected Post Processor does not support an Automatic Tool 
Changer then a box with an error message will appear. 
 
 

• Using the black arrow,  Transfer all the toolpaths into the right hand 
window as shown. 

 
 

 
 
 
Note: The Vertical arrows can be 
used to reorder the toolpaths for a 
single output file.   
 
 
 
 
 

 
 
 
• Ensure the same machine output file is selected as before. 
 
 
• Select Save to output the combined files. 
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The operation has failed and the above error message appears. The files were unable to be 
processed for two reasons. 
 

1. The selected Machine (post processor) does not support tool changing itself.  
 
 
2. All tools are currently identified as Tool number 1.  The Tool Number is essential to 

identify the location of an individual Tool in the tool changer or carousel 
 

 
 
 
 
 
 
 
 
The Tool Number can be defined in a number of ways. 
 
 

1. Entering the tool number within the defined tool of 
the toolpath.  The Toolpath must be recalculated. 

 
 

 
 
 
 
 
 
 
 
2. Entering/Editing the default tool 

number defined in the Tool database. 
 
 
 
 
 
 
 
 

3. The simplest way is to change the tool number by first highlighting the tool in the 
Toolpaths Tab. 
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Expand  the Toolpath parameters Tab at the 
bottom of the Toolpaths Panel. 
 
 
The Tool number can be changed here and updated by 
just selecting Apply. 
   
 
  
  
 
• Use any of the methods described above to assign Tool numbers as 

shown in the image below. 
 

• Select Save Toolpaths  from the Toolpath Operations area. 
 
• Move all the Toolpaths to the right hand window. 
 
• Reorder the Toolpaths as required to machine. 
 
 

 
 
 
• Change the Machine output file to Axyz_MultiTool_Arc_MM.  
 
• Select Save. 
 
Note: No Error message is displayed and now allows the files to be saved as one. 
 
• Locate C:\temp and enter the File name as Savannah and select save. 
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NC code can be viewed in WordPad for analysis or editing if required. 
 
 
• Browse to the C:\Temp directory to see the saved toolpaths. 
 
 
• Right mouse click on the Toolpath an open with WordPad. 
 
 

 
 
 
 
The outputted NC code can be viewed. 
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9. Engraving 

Introduction 
 
Smart Engraving allows you to input a selection of Roughing (End Mill) and Engraving 
(V Shaped) tools, which create a series of efficient toolpaths within the defined vector 
selection ultimately producing the required engraved form. Different machining parameters 
and tool settings can be applied to each toolpath from within the Smart Engraving options. 
For small detail it is possible to run Smart Engraving with one ‘V’ shaped tool.  
 
If more than one tool is selected, Smart Machining is performed. This is the strategy where 
smaller tools will only machine the areas previous tools were unable to reach. If conical tools 
are used, options to enable 3D corner sharpening moves are available. 

Smart Engraving Exercise 
 
• Open the model arch.art from: D:\users\training\ArtCAM Data. 

 
 
 
 
 
The Smart Engraving options provide for finishing of 
sharp internal corners for the finishing tooplaths using the 
‘V’ Bit Cutters.  
 
The selected vector is the top edge of the detail. The 
option to offset the End Mill for the Engraving Tool (it 
leaves additional material on) is used to give the V-Bit 
finish tool some material on each side to cut out, to 
balance the loading on the V-Bit tool. 
 
 
 
 
 
 
 

 
• Select only the Inner feature vector as shown above. 
 

• Select Smart Engraving  from the 2D Toolpaths Tab. 
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• Enter a Start Depth of 0 and a Finish Depth 

of 5mm and Tolerance as 0.01. 
 
• Select the option Vectors are on surface. 
This assumes the vectors lie at the top of the surface. 
Unticking the box assumes the vectors lie at the bottom.  
 
• Select Offset End mills for Engraving 

tools. 
The End Mill tool will be offset to ensure the engraving 
tool will be able to machine an angled wall. 
 
•  Set Safe Z as 5 and Home Position X0 Y0 

Z5. 
• Add a 6mm and 3mm End Mill tools, along 

with a Small V-Bit 12mm 90 Degree tool.  
Note: the V-Bit tool will have to be copied and edited 
within the Tool Database from an existing stored tool. 
 
• Enter an Allowance of 0.1mm only on the 

End Mill 6mm tool. 
 
Note: Several parameters can be defined independently 
for the specific tool selected (highlighted) in the form.  
 
• Select Do corner Sharpening only for the V-

Bit 12mm 90 degree tool. 
 
• Set the Material Thickness to 25.4mm with 

the Z0 origin at the top. 
 
 
 
The machining calculations will take the vector to be the top edge of the chamfered detail.  
 
 
• For the End Mill 6mm tool set the tool Stepover to 4mm and the 

Stepdown to 5mm. 
 
• For the End Mill 3mm tool set the tool Stepover to 0.5mm and the 

Stepdown to 1mm. 
 
• For the Small V-Bit 12mm 90degrees tool set the tool Stepover to 

0.1mm and the Stepdown to 5mm. 
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• Enter the Name Smart Engraving. 
 
• Select Calculate Now. 
 
• Close the form 

 
As always, The Toolpaths are listed in 
Toolpaths fly out panel. 
 
 

 
 
 
All of the 3 toolpaths created by the Smart 
Engraving options are displayed and could all 
be simulated at the same time. It would however 
be better to simulate them one at a time to see 
more clearly what each one is actually 
machining.   
 
 
 

 
 
 
 
End Mill 6mm tool 
This operation performs Area Clearance on 
the whole aperture to full depth (less than the 
Stepdown value). 
 
 
 
 

 
 

 
 
End Mill 3mm tool 
This operation performs Area Clearance on 
areas inaccessible to the larger End Mill. In the 
small enclosure at the tip the 1mm stepdown 
causes machining to occur at several Z 
descending Levels. 
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Small V-Bit 12mm 90degree tool 
With corner sharpening on, the tool will 
ramp along internal corner intersections to 
produce the sharpened and completed 
shape. 
 
 
 
 

 
 
• Select the 2D View and select the four triangular vectors and the text 

arc. 
 

 
 
 
 
As these are only small indentations only one V-Bit tool will be 
required. 
 
 
 
 
 
 
 
 
 
 
 
 

• Select Smart Engraving  from the 2D Toolpaths Tab. 
• Enter a Start Depth of 0, a Finish Depth of 3mm and a Tolerance of 

0.01mm. 
• Select the Small V-Bit 6mm 90 degrees tool. 
• Change the Stepdown to 3mm. 
• Select Tool Clearance Strategy as Offset. 
• Select the option Do Corner Sharpening. 
• Select Calculate Now, followed by Close.  
 
Note: The name Smart Engraving 1 was automatically provided. 
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• Select Simulate Toolpath.  
 

 
 
The small features and text have been 
machined using a single operation with 
the V-Bit tool. 
 
 
 
 
 
 
 

 

Machine Along Vector  
 

The Profile Toolpath option   also provides the option to directly trace along a selected 
vector, to a user defined depth. A typical application would to mark a scribe line around the 
outside of a component form.  
 
• Select the Outer vector as shown below. 
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• Select Create Profile Toolpath  from the 2D Toolpaths Tab. 
 

 
 
• Enter a Finish Depth of 1mm. 
 
• Select a Ball Nose 1.5 mm tool. 
 
• Enter a name Along vector BN3 
 
• Select Calculate Now. 
 
• Close the form. 
 
 
 
• Simulate the toolpath 
 
 
 
 
 
 
 

 
 

 
 
 
The outer limit of the component has 
been ‘scribed’ with the 1.5mm Ball 
Nosed tool. 
 
 
 
 
 

 
• Select File - Save As and enter as File Name SmartEngraving.art in: 
D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 
 
• Select File – Close Model. 
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10. Drilling  

Introduction 
 
In the 2D Toolpaths section there is a Drilling option, which uses selected vectors for 
defining the hole positions. The hole positions are defined either Central to circle vectors, at 
vector Node points, at a vector dimensional Centre, or on the Plunge Move positions of a 
selected 2D Toolpath.  
For creating a Drill tool the V-Bit tool page is used as this has the same geometrical shape. 
 
  
• Open the model Drilling.art from: D:\users\training\ArtCAM Data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select the 6 Circle vectors. 

• Select Create Drilling Toolpath  from the 2D Toolpaths Tab. 
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• Enter a Start Depth of 0, a Finish Depth 
of 20mm and a Plunge Clearance of 2mm. 
 
Plunge Clearance is a separate Safe Z for Drilling. 
 
• Set a Safe Z of 5mm and a Home 
Position of X0 Y0 Z5. 
• Select a Small V-Bit 6mm 90 degree tool. 
• Change the Tool Stepdown to 6mm. 
 
• Select the option Selected Circular 
Vectors. 
 
• Select Use Peck Drilling and enter a 
Retraction value of 4mm.  
The Drill will lift 4mm at each incremental Stepdown 
depth of 6mm. 
 
Optimise is one of several options controlling the order 
in which a hole pattern is Drilled. 
 
•  Define a Material Thickness of 25.4mm 
and set Z Zero at the top. 
• Enter Name as Name Drilling-1. 
• Select Calculate Now. 
• Select Close. 
 

 

• Select Simulate Toolpath.  
 

 
 
Note: To observe the 4mm upward 
Pecking movements at 6mm 
incremental depths, simulate at 
normal speed. 
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The Drill Centre of… All Selected Vectors will now be 
demonstrated. The drilled hole will be positioned dimensionally 
central to the selected vector. 
 
 
 
 
 
 
 
• In the 2D View select the oval vector. 
 
 
 
 
 
 
 
 
 
 

• Select Create Drilling Toolpath  from the 2D Toolpaths Tab. 
 
• Enter a Start Depth of 0, Finish Depth of 6mm and a Plunge Clearance 
of 2mm. 
 
• Use the same Small V-Bit 6mm 90 degree tool. 
 
• Change the Tool Stepdown to 6mm. 
This means the drilling will be performed in a single peck. 
 
• Define Drill Centre of … as All Selected Vectors. 
 
• Enter as Name - Drilling-2. 
 
• Select Calculate Now. 
 
• Close the form. 
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• In the 2D View select the 5 Sided vector. 
 
 
 
 
 
 
 
 
 

• Select Create Drilling Toolpath  from the 2D Toolpaths Tab. 
 
• Enter a Start Depth of 0, a Finish Depth of 10 and a Plunge Clearance 
of 2mm. 
• Use the same Small V-Bit 6mm 90 degree tool. 
 
• Define Drill Centre of… as All Selected Vector 
Nodes. 
 
• Enter as Name - Drilling-3. 
 
• Select Calculate Now. 
 
• Close the form. 
 
 
 
 
 
 
 
• Simulate the Toolpath.   
 
Observe the drill plunge directly to the 
full depth of 10mm, at the Node points of 
the 5 sided vector. 
 
 
 
 
 
• Select File - Save As and a enter a File name as Drilling Example in: 
D:\users\training\COURSEWORK\ArtCAMPro-Jobs. 
 
• Select File – Close Model. 
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11. Toolpath Templates 

Toolpath Templates 
 
A Toolpath Template is a file containing one or more unprocessed machining strategies 
stored outside ArtCAM as a .tpl file. A previously stored Toolpath Template is imported 
into ArtCAM and the associated machining strategies can be then edited (if required) before 
the toolpaths are regenerated for the current model.  
 
The benefit of Toolpath Templates is that a whole set of unprocessed machining strategies 
can later be loaded into ArtCAM with all the tooling and settings already set for the user 
specific application or for a series of similar ArtCAM models. 
 
• Open the model train-breadbin-lid.art from: D:\users\training\ArtCAM 

Data. 
 
• Activate the Toolpaths fly out panel if not already visible. 
 
 

 
 
This ArtCAM model contains four Toolpaths, one of 
which requires a closed vector to control the area to be 
machined. When a Template is Saved/Created, all 
toolpaths that exist in the model are included in the 
output file.  
 
 
 

 

• Select Save Toolpath as Template  from the Toolpath Operations 
area. 

 
 
The toolpath template is a special file type 
(*.tpl) and is stored outside of the ArtCAM 
model.  
 
It is a good idea to be as descriptive as 
possible with the template name. 
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• Select the area D:\users\training\COURSEWORK\ArtCAMPro-Jobs and 

enter the File name EM12-VBIT32-90-EM12.tpl. 
 

 
 
• Select Save. 
 
The template can now be loaded into a different model or, if these toolpaths have been 
deleted, they can be loaded back into the current model. 
 
 
• In the current model, Select each toolpath and 

delete it using Delete Toolpath  in Toolpath 
Operations. 

 
 
 
(It therefore assumes at this point, the Relief has just been created……….)  
 

• From Toolpath Operations, Select Load Toolpath Template.  
 
• Browse and Select the previously created file EM12-VBIT32-90-EM12.tpl 
 
• Select Open. 

 
 
The Unprocessed toolpaths are displayed in the Toolpaths 
Tab. In addition, there are no ‘display toolpath’ tick boxes 
below ‘Show in 2D/3D’ indicating that they have not yet 
been calculated. 
 
 
 

 

11.2 Issue ArtCAM Insignia 2010 



ArtCAM                                            11. Toolpath Templates 

• From Toolpath Operations, Select Batch Calculate Toolpaths.  
 
 

 
 
 
The form appears with all of the toolpaths listed. By default 
all of the toolpaths are ticked, ready to be included in the 
Batch Calculate process. 
 
Note: If use a selected vector is specified in the toolpath 
page, a suitable vector must first be created and selected if 
Batch Calculating the template on a different model. 
 
 
 
 
 

 
 

 
 
• Select the Start tab to commence calculation 

of the toolpaths. 
 
 
 
• Close the dialog box when finished. 
 
 
 
 
 
 

 
 
All of the toolpaths have been calculated including the selection of a suitable limiting vector. 
As the Toolpath Template is being applied to the same model then the vectors will be 
remembered and selected automatically. If the Toolpath Template is applied to a different 
model then these toolpaths will have to be opened on an individual basis and suitable 
limiting vectors created and selected before applying Calculate Now. 
 

• Simulate All Toolpaths.   
 
 
• Select File Save and then Close. 
 

                                                                 Issue ArtCAM Insignia 2010                                                         11.3 



11. Toolpath Templates                                                                                  ArtCAM 
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12. Machining Inlays 

Inlays 
 
An Inlay is text or vectors with depth that is machined out of the material. The Inlays are 
usually machined in pairs using the same tool, so the male inlay will fit inside the female 
pocket or hole inlay. 
 

 
 

The Inlay Wizard  creates the selected type of 
Inlay from the selected vector. 
 
 
 
 
 
There are four female inlay options and two male 
options. The male inlay will fit inside the female inlay 
if an identical vector and identical tool is chosen.  
 
 
 

 

Inlay Exercise 
 
• Create a New Model of Width and Height of 50mm and a Thickness of 

5mm. 
• Select the Origin in the Centre and remaining options as shown below. 
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• Create a Vector Text  of the letter ‘P’ using Arial, 
Western and a size of 25mm. 

 
• Position the text in the middle of the model (shortcut F9 

to centre in page). 
• Ensure it is selected. 
 
 
 
A Male and a Female Inlay toolpath will be calculated. 
 
 

• From the 2D Toolpaths page, select Inlay.  

• In the Inlay Wizard page, select Female Pocket.  
 
• Enter the values and select the tools exactly as shown on the image below. 
 

 
 
 
 
• Enter a Finish Depth of 4mm. 
 
• Set a Safe Z and Home Z of 5mm. 
 
• Locate and Select any End Mill of 1.5mm for 

the Finishing Tool. 
 
• Locate and Select any End Mill of 3mm for the 

Roughing Tool 
 
 
• Leave other options as shown 
 
 
 
 
 
 
 
• Enter a name Inlay Pocket and then select 

Calculate Now. 
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The Inlay toolpath has been generated. Note at the corners 
the toolpath is rounded. This is to ensure that it will be able 
to accommodate the Male insert. 
 
 
 
 
 
 
 

• Select Simulate Toolpath.  
 
 

 
 
 

If an Inlay hole was selected,  the depth of the 
Inlay is calculated form the material. 
 
 
 
 

 

• Select Reset Simulation.  

• From the 2D Toolpaths page, select Inlay.  
 

• In the Inlay Wizard page, select Male Straight.  
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• In the Male Insert page, Enter the same values and select the same tool 
as in the Female Inlay Pocket page.  

 
 
 
 
 
 
• Enter a Finish Depth of 4mm. 
 
 
 
• Locate and Select the same End Mill 

1.5mm Tool. 
 
• Leave other options as shown 
 
 
 
• Enter a name Male Insert and then select 

Calculate Now. 
 

 

• Highlight Male Insert Toolpath and select Simulate Toolpath.  
 
 
 

 
 
 
 
This Male insert will fit perfectly inside the female 
pocket. 
 
 
Note: When you are generating Stepped inserts, the 
shoulder is offset from the vector, so with make 
inserts, this make the actual vector larger. 
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13. Nesting Vectors 

Introduction 
 
Nesting is an automatic procedure, which re-arranges the selected vectors within the first 
vector to use as little space as possible. This is especially useful if you require the maximum 
use of the material being used. Offsets for the tool radius and an offset between the toolpath 
are used, so there is enough room to machine out the vectors. 
 

Nesting Vectors Exercise 
 
• Create a New Model of Width 150mm, Height 50mm and Thickness of 

5mm. 
 
• Set the other options as shown below.  
 
 
 
 
 
 
 
 
 
 
 
• Select OK. 
 
• Create a Rectangle of Width 145mm and Height 45mm at a position of 

X0 Y0. 

• Create and position the text  all text to fit into this space, using font 
Bookman Old style, size 10mm. 
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• Select the Vector Text, right mouse select the 

option Ungroup Vector(s) from the flyout 
menu. 

 
• Select both the Rectangle (first) and the Text vectors. 
 

• Select Nest selected vectors  from the Vector Creation Toolbar. 
• In the Nesting page, enter the values as shown in the image below. 
 
 

 
 
 
This page defines, what tool will be used and the 
Allowance between the toolpaths, to stop them 
overlapping.  
 
 
To allow ArtCAM Insignia to find the optimum 
nesting, the Angle that the vectors can be rotated by 
can be set. If a step Angle of 10 degrees is chosen, 
each vector will be rotated by 10 degrees and then 
by another 10, until the optimum nesting is found.  
 
Mirror parts and parts in parts are alternative 
Nesting options, which if suitable may nest the 
vectors more tightly. 
 
 
 
 
 
 
 
 

 
 
• Select Nest. 
 
 
 
 
 
The leftover material vector is made up of several small bits and is therefore grouped 
together. This can be used later to define the boundary of the material remaining. 
 
• Close the form. 
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• Delete the leftover material 

vectors. 
 
 
 
• Select File - Save As and enter a file name as my-nest in 

D:\users\training\Coursework\ArtCAMPro-Jobs. 
 
• Do not close the model. 
 

Re-ordering Toolpaths 

A profile toolpath, with a lot of tool lifts, around the model, will not necessarily move in the 
order you require. A selected profile toolpath can be reordered where each lift appears. 
 
• Select all the text vectors excluding the rectangular outer vector. 

• In the 2D Toolpaths tab, select 2D Profiling.    
 

 
• Select Outside,  
 
 
 
• Select a Start Depth of 0, and Finish 

Depth of 10.  
 
 
• Select a 4mm End Mill tool (you may 

need to create this tool). 
 
 
 
 
The ordering sequence can also be defined 
here.  
  
• Select 15mm for Machine Safe Z, with the 

Home Position at 0 0 15. 
 
• Name the Toolpath EM4Profile. 
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• Select Calculate Now and then Close the form. 
 
 

 
 
 
The vector group is machined. The order or machining can be 
modified to suit either from within the Toolpath  or separately 
from the Toolpaths Tab.  
 
 
• In the 2D view, select just the Profiling toolpath. 
 

• From the 2D Toolpaths Tab, select Toolpath Ordering.  
 

 
 
 
 
 
 
 
 
 

 
The toolpath ordering form appears and the current 
ordering is displayed on the toolpath.   

 
 
With the segment position set at 1 you can manually pick each sector in turn and starting 
from one, renumber the segments. This can take some time if you have a lot of segments. 
 
  
• Select Order segments from start to re-order the toolpath. 
• Select the profile Toolpaths of individual letters to define the preferred path. 
• Close the form. 
• Simulate the toolpath to check the machining order. 
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14. Toolpath Panelling 

 

Toolpath Panelling 
 
Toolpath panelling will cut the ArtCAM toolpaths into panels sizes to suit your machine. It is 
important that the datum is set at the lower corner of the sheet. If the datum is elsewhere the 
model has to be move, the vectors moved and the toolpaths re-calculated. 

Toolpath Panelling Exercise 
 
• Open the model train-breadbin-lid.art from: D:\users\training\ArtCAM 

Data. 

• Select Simulate All Toolpaths  to view the calculated toolpaths. 
 

• Draw  the toolpaths over the simulation. 
 
 

 
 
 
These toolpaths are going to be cut into panels using toolpath panelling. 
 
• Switch to the 2D view. 
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• From the Toolpath Operations tab, select Toolpath Panelling.  
 
 
 
The panelling page appears. The sizes of the panels are set here and are displayed by dashed 
lines in the 2D view and a number in the middle of the panel. 
 
 

 
 
 
• Enter a Panel Width of 200mm and 

a Height of 200mm. 
 
 
• Select Update Panels.  
 
 
 
 
 
 
 
 
Selecting Display Panel Info produces a HTML 
summary which can be printed independently. 
 
 
 
 
 
 
 
 

 
 
 
 
The panels can be seen clearly defined by 
the dashed lines. If required, the panels can 
be manually modified by dragging (for 
example if the panel goes through a feature 
in the wrong place) 
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• Drag the panel borders to avoid passing through the end of the side 

details as shown. 
 
 
 
 
 
 
This is the best solution with 
reasonable panels of 
approximately the same size. 
 
 
 
 
 
 
 

 
 

• Select Horizontal Panel Numbers  to update 
and reflect the new Width and Height panel sizes. 

 
 
 

 
 
 
• Select Include Toolpath Summary. 
 
• Select Display Panel Info. 
 
 
 
An html file appears with the panel information on 
which can be printed. 
 
 
 
• Close the HTML summary page. 
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• Select the 3D View.  
• Select Display Selected in the 3D view 

Toolpath Drawing. 
• Select Panel: 2 and select In Finished Job. 
 
 

 
 
 
The toolpath is shown in the job with 
the extended toolmoves from the left 
corner datum. 
 
 
 
 
 
 

 

• Select Panel: 2 and Select At Origin.  
 

 
 
The toolpath is shown at the origin as if you put panel 2 
in your machine. 
 
All of the toolpaths in the panel are not displayed in the 
toolpaths list as there may be lots of them. 
 
The toolpaths are saved to disc. The original toolpath is 
selected and then ArtCAM saves the panelled post 
processed toolpath is a named directory. 
 
 
 

 
 
 
• Select Save Toolpaths.  
• Select the Area Clear toolpath, a suitable 

Machine option and select Save. 
• Enter the File name Panelling and press Save. 
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• Locate the directory into which the post processed files were saved. 
 
 
 
• The 6 toolpaths called Panelling_P1 to Panelling_P6 are generated for 

panels 1 to 6. 
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